
Release:
7.2.2

Highlights:

This release contains bug fixes for various staff modules and WebVoyáge.

General documentation for this release:
http://docs.exlibrisgroup.com/docportal/



KB Number Description Solution Implementation Notes Related Documentation Module Issue 
Number

16384-2711

In Acquisitions, if you go to File>Search to get to Boolean searching, then 
select Help>Help Topics, you get a Run Time Error 6:  Overflow  message and 
are kicked out of the client.

Help is now invoked from the search form using the same function 
as from the other forms.The search form was still calling an older 
function that caused a run time error. Acquisitions 14702

16384-28257 

In Acquisitions, in Session Preferences, the user changes the Default 
Workspace to be Search Orders.  When first logging in, the Listbar displays the 
Orders choice with 3 icons (New Purchase Orders, New Order from 
Bibliographic Record, Search Orders).  After the initial login, the New Order 
from Bibliographic Record never displays again. 

The icon was removed for the New Order from Bibliographic Record 
feature from the listbar. Its corresponding menu option was 
removed, too. This feature is not available.

Acquisitions 15075

16384-2734

In Acquisitions, when in an item window (either creating or viewing), the 
keyboard equilavent, Alt-C, does not work to close the window. You must click 
the word Close. 

The hotkey for the Price field was reassigned on the item form from 
ALT-C to ALT-I so that it does not conflict with the ALT-C for the 
Close button. ALT-C now closes the window as expected.

Acquisitions 15090

16384-28258 
In Acquisitions Serials Check-In, if you click done on the recap screen, the 
Other search button is inactive.

The logic was changed to ensure that the Other search button is 
enabled at the correct times. Acquisitions 15125

16384-28259 

In Acquisitions, if one clicks the Subscription Pattern button on the Type tab of 
a line item and the main Acquisitions window is minimized, the subscription 
pattern window does not open until you click the Voyager Acquisitions button 
from the taskbar at the bottom of the desktop.

When the subscription maintenance form receives focus, it is 
ensured that the main window (its parent) has a normal state, that 
is, is not minimized.

Acquisitions 15129

16384-2885

On the PO screen in Acquisitions, it should not look as if the Alt-a causes three 
very different operations: (1) Go to the Header tab (2) Save the PO on the 
toolbar line, and (3) Approve the PO.

The alt hotkeys were removed from commands on the toolbar.  The 
menu hot keys can be used to get at the same functions.

Acquisitions 15214

16384-2970
In Acquisitions Serials History, using alt-s and alt-o just highlights the start over 
and holdings buttons respectively.

The hotkeys were changed for Start Over (ALT-T) and Holdings 
(ALT-G). Acquisitions 15333

19345

BatchCat has a problem with a 245 field that begins with $k instead of $a. A bibliographic record that has a 245 field starting with a subfield k 
and no subfield a, can now be added to Voyager via BatchCat. The 
sofware now only validates the presence of at least one subfield in 
the 245.

The client installation should install a new 
batchcat.dll.

BatchCat 15786

16384-3153

In circulation, when you perform a patron name search, the keyboard 
equivalent (the hot key alternative to clicking the boxes with the mouse) is the 
same (the letter L) for both the Library and Last Name input boxes.

The Library field hotkey was changed to ALT-Y so that it does not 
conflict with the Last Name field hotkey.

16106

16384-2871

If there is a discount for a vendor account and that account is selected in the 
order portion of a Bulkimport Rule, the discount is not applied to line items on 
the PO created by Bulkimport.

If there is a discount for a vendor account and that account is 
selected in the order portion of a Bulk Import Rule, the discount will 
be applied to all line items on the PO created by Bulkimport.

Acquisitions 16280

16384-2971

In Acquisitions, you are unable to click the Override Rules tab when you are 
looking at a Summary Fund (this is how it should be because Summary Funds 
don't have any money allocated to them).  However, you can access the 
Override Rules by opening the Fund menu and selecting it from there.  Then 
you can change the values and save the values to the database. You should 
NOT be able to do this.

When a fund is selected from the ledger/fund tree, the fund tabs are 
already enabled/disabled based on the fund type.  The code was 
updated to also enable/disable the fund menu options which 
correspond to the tabs.

Acquisitions 16385

16384-2886
In Acquisitions, the Alt-V command only moves one to the Vendor History tab 
and not ever to Save and Close the PO window.

The alt hotkeys were removed from commands on the toolbar.  The 
menu hot keys can be used to get to the same functions. Acquisitions 16758

19376
In System Administration, operators that are able to delete items are now also 
able to delete MFHDs.

Permission to delete an item in the cataloging profile is no longer 
dependent on the permission to delete a holdings record. System Admin 17070

16384-2888

In Acquisitions, you should be able to create separate Notes for a fund on 
different ledgers.

Fund notes were enabled to be created for a fund on different 
ledgers.

Acquisitions 17167

16384-2884

If you try to save an invoice with an invoice number with more than 25 
characters, you get the message an error occurred while storing the invoice!

The MaxLength property of the invoice number edit box was set to 
25. This now matches the database limit for that field.

Acquisitions 17286

19578

The system allows you to create a location code with a space at the end. This 
gives you an unauthorized or invalid location in subfield b of 852  error 
message in Cataloging when trying to save a MFHD using that location code.

New location codes can no longer be saved with trailing spaces. 

System Admin 18248

16384-28260 Tag table errors. The errors have been corrected. New tag tables are needed. Voyager 37788

16384-5265

Only one limit may be applied to each quick limit option. The logic was added to handle multiple limits to be associated with 
one quick limit drop-down option. A vertical bar was used to define 
multiple limits in the webvoyage.properties file.

Changes to webvoyage.properties.  Comment 
added to the Limit To section.

OPAC 16384-1969

16384-5377

The post limit filters display in no particular order, and there is no way to 
change it.

The post limit filters were made to display in the same way as the 
quick limits by using the order information from the 
webvoyage.properties file to sort the post limits.

OPAC 16384-2049

16384-7620
The Headings list page does not show headings type. The headings type was added for each heading to the Headings list 

page in WebVoyáge.
Changes to cl_resultHeadings.xml and 
resultHeadings.css. OPAC 16384-2850

16384-22340

Running circjob 6 at the pickup library after a hold has expired does not remove 
the entry from ub_hold at the holding library.

Circjob 6 will remove the ub_hold record at the holding library when 
the job is run at the pickup library to clean up expired holds.

Universal Borrowing 16384-3777

16384-9558

When a MFHD tag is used more than once, there is no linebreak or space 
between one subfield and the next. 

This was found to be working correctly in 7.2.0, 7.2.1 and 7.2.2.  No 
fix is required in this service pack. OPAC 16384-4001
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16384-10197

The order in which individual records are presented post Call Number Browse 
search deviates from the order in which they display in the results list, 
sometimes skipping records, sometimes displaying out of order completely.

Problems with call number browse searching from the holdings 
page with the Previous or Next holdings pointer were corrected.

OPAC 16384-4098

16384-12996

The meta tag redirect is loaded after the timeout redirect. IE7 only interprets 
the first meta redirect so the login page does not redirect, and the display is 
missing information.

In WebVoyáge on the IE7 browser, bypassing the login screen for 
external patron authentication works successfully in 7.2.2, 7.2.1 and 
7.2.0. No fix is required in this service pack. OPAC 16384-5090

16384-13399
Anytime there is more than one demerit (any balance) applied to a patron 
record, the total is incorrect on the top right under Your Items.

The demerits total on My Account page in the Your Items box was 
corrected. OPAC 16384-5153

16384-17650
When viewing holdings information for a record, the 866 holdings information 
displays twice.

The 866 holdings information is processed separately from the 
853/863 pairs.  The 866 information now only displays once.

Changes to 104X_display.xsl.
OPAC 16384-5841

16384-15281

Circjob 43 notes that the row exists and that it is removing it. However, it 
doesn’t actually delete the row.

The orphaned ub_hold rows from the remote database’s ub_hold 
table are cleared by getting all fields of the table row defined 
correctly in the SQL delete statement. Batch jobs 16384-5953

16384-16291

If a patron's record is expired, viewing the account information in WebVoyáge 
shows a block that states All Patron Groups Reason  without providing any 
additional details.

This was found to be working correctly in 7.2.2. No fix is required in 
this service pack.

OPAC 16384-6481

16384-16497
Some fields in the Circulation and Call Slip clients cannot be added in Query 
Studio or Report Studio.

The addition of all fields is allowed in the presentation layer to 
reports using Query Studio or Report Studio. Voyager Analyzer 16384-6609

16384-16834

Grace periods are not recognized for intervals set to minutes (fines are 
assessed starting as soon as a booking is overdue). 

Grace periods set in Media Policy Settings are applied when the 
interval frequency is set to minutes or hours. Media System 

Administration 16384-6689

16384-17201

If a Patron Group is set to Display OPAC Messages in System Administration, 
but the corresponding messages are not set up in WebVoyáge, a system error 
is encountered when viewing a results list with an item checked out to a patron 
in this group.

This was resolved by the fix to KB item 16384-24257 (issue 16384-
9713).

OPAC 16384-6705

16384-17202

Items marked as Lost display with a status of 13. The missing status was added for an item marked as lost, and the 
corresponding customized message displays for any item with a 
status of lost.

Changes to webvoyage.properties.  

OPAC 16384-6721

16384-16977

When a patron views his/her charged items via WebVoyáge, checks Select All, 
clicks Request Renewal, and if the charged items range across multiple 
databases, only the items from the first database listed has its items renewed.

The cl_myAccount.xsl file was modified to send all of the items 
when the select All check box is selected on the My Account page 
for charged items. It now renews all items from multiple databases.

Changes to cl_myAccount.xsl.

OPAC 16384-6737

16384-17654

Using the nonFillingIndicator attribute within displaycfg.xml and/or 
displayHoldings.xml has no effect. Redirects use the full title as stored in 
Cataloging, not taking into account any nonfiling indicators.

The display.xsl file was modified to retrieve the value of the 
second indicator from the MARC record itself and the 
nonFillingIndicator variable was changed to nonFilingIndicator.

OPAC 16384-6929

16384-18020

Limits are available, but do not work when multiple libraries are searched. A partial fix was completed until the next service pack where the 
post limits problem will be corrected. In 7.2.2, limits (pre and post) 
are now only available when searching a single database.

OPAC 16384-7009

16384-18021
Public notes and Enumeration set in E-item course reserve records do not 
display in the OPAC record for that e-item title.

The display.xsl file was modified to include public notes and 
enumeration fields for an E-item on the holdings page.

Changes to display.xsl file.
OPAC 16384-7025

16384-18248
Post-simul-search sort only displays local results. The Sort By option is only available when searching a single 

database. OPAC 16384-7185

16384-18385
On the short loan request form, the start time drop-down list does not refresh 
when selecting different copies.

The start time drop-down list will refresh when a different copy is 
selected on the short loan request form.

Changes to deploy cl_requestForms.xsl.
OPAC 16384-7266

16384-18387
The bibliographic/MFHD information that displays in the bibliographic level form 
does not include location, and it cannot be added.

The location now displays in the bibliographic level request if 
requested in requestholdingscfg.xml.

Changes to requestholdingscfg.xml.
OPAC 16384-7283

16384-18884

Using the print option to print a brief record may not print all of the displayed 
labels and/or fields if there are multiple MFHDs which span across more than 
one page.

The brief record selection now prints all of the information generated 
on the print page using both browsers (Internet Explorer and 
Firefox).

Changes to printBriefRecord.css.

OPAC 16384-7649

16384-18914
When using Access 2007 with Reporter, multiple runtime errors are 
encountered because of an inability to locate the utility.mda file.

This was found to be working correctly in 7.2.0, 7.2.1, and 7.2.2.  No 
fix is required for this service pack. Reporter 16384-7745

16384-18917

Running an index regen with all of the elink options set to Y only rebuilds the 
elink_index table for records with record_type A, B, or M leaving out 
records with a record_type of E.

An option was added to the index regen process to rebuild the 
elink_index entries with a record_type of E with e-item data 
from the eitem table.

Changes to the REGEN.indexes script.

Server issues 16384-7777

16384-19974

The URL returned when multiple items are renewed includes data for each 
item renewed.  These URLs can be too long for Internet Explorer or Firefox to 
display.

The form action was modified to post so that patrons with a long 
charged items list can now select the Renew All feature and get a 
successful display.

Changes to cl_myAccount.xsl. The form 
action was changed to POST.

OPAC 16384-8193

16384-20162

If the bibliographic record in question has multiple holdings records and, at 
least, one of which has multiple items, you receive an error message when you 
attempt to change the request from title to copy level.

This works in 7.2.0 and above. No fix is required for this service 
pack.

Circulation 16384-8321

16384-20898

The hold shelf life for a title level request placed through WebVoyáge is being 
dictated by the All/All matrix setting in the policy definition that contains the circ 
happening location where the item was discharged.

The patron group ID has been added to Add Hold Recall requests.

OPAC 16384-8626

16384-21511

When a window other than the patron record is in focus, clicking the fine fee 
button on the patron record sometimes results in a run time error 13.

The sporadic errors that could occur when clicking any button/icon 
such as Fines/Fees or Charged Items on the Patron form while 
having focus on another form such as the discharge form were 
corrected. Circulation 16384-8817
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16384-22785

If an hourly/minutely loan item is charged out on a closed day or open 
exception date (with changed hours) and the Apply Fixed Due Time to 
Overnight Loans box is checked, any hourly/minutely loan is assessed a due 
time of the library’s close time on the exception day/closed day.

The due date calculations were corrected so that hourly- or minutely-
made loans should be assessed the correct loan period when a 
charge happens on a closed or exception date.

Circulation 16384-9330

16384-22978

Circjob 31 does not suspend all eligible patrons when it encounters a patron 
with a large number of entries in the fine_fee table.

The list of fine IDs being posted sometimes exceeds the capacity of 
Oracle to select them using a single list. The select to complete by 
breaking the list of fine IDs down into smaller chunks that do not 
exceed Oracle’s capacity was enabled. Batch jobs 16384-9345

16384-22979

E-mails that would be sent by the OPAC as the result of any of the request 
forms are never delivered.

The path of the Cataloging system call was altered from 
/usr/bin/cat to /bin/cat for Linux. The process of sending e-
mail uses the cat command to send the e-mail file to the sendmail 
program. Linux places the cat command in a different directory 
other than UNIX . OPAC 16384-9377

16384-24257

When searching another Voyager database that has Status Patron Groups set 
up in System Administration, you receive a WebVoyáge system error when a 
title checked out to a patron that is in one of the Status Patron Groups is 
included in the results list.

The logic has been added to display the results list without an error 
when searching another database.

Universal Borrowing 16384-9713

16384-24339

When circjob 43 updates the home database's ub_charge.due_date, it 
seems to be pulling the remote database’s 
circ_transactions.charge_due_date, not the 
circ_transactions.current_due_date.

The charge due date has been changed to the current due date 
when updating the home database’s ub_charge table based on the 
remote database’s circ_transactions table.

Universal Borrowing 16384-9761

16384-26097 

vprimo extract:extract dies when it encounters a certain record in the 
processing.

When parsing the bibliographic record, it continues with the extract 
process if the 001 tag is not found.

Primo extract 16384-10145

16384-26801 

WEBV:renews look to the wrong policy definition for some matrix data. It has been updated to make sure the correct policy is used when 
determining item or patron blocks. It is either based on the item’s 
location or the OPAC circ desk if coming from the OPAC or the 
Circulation circ desk when coming from the Circulation client.

OPAC 16384-10465
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